
Appendix 4 – NDSR Tutorials  Page A4.1 

Appendix 4 
 

NDSR Tutorials 
 

This appendix contains three tutorials that are valuable orientation exercises for all new NDSR 

users.  It may be helpful to read “Appendix 1, Using Windows” and “Appendix 2, NDSR Menu Bar” 

before beginning the tutorials.  These tutorials focus on using keyboard shortcuts because data entry 

using the keyboard is generally faster. 

 

If possible, allow yourself at least two hours to focus on the tutorials.  It is best if you can work 

through them in a single session.  If you do need to exit a tutorial in the middle, finish describing the 

item you are on and then select the FINISH LATER button.  When you return to the tutorial, open the 

tutorial record and select the CONTINUE RECALL button. 

 

The Intake Record Tutorial provides detailed instructions for starting NDSR, creating a project, 

entering an intake record with the Dietary Supplement Assessment Module (DSAM), and managing 

projects and records.  It will familiarize you with the NDSR program format, the databases, and the 

system capabilities. 

 

The User Recipe Tutorial provides detailed instructions for creating a User Recipe project, entering 

a User Recipe, and inserting a User Recipe into an intake record.  It will familiarize you with the 

User Recipe feature in NDSR.  This tutorial assumes that the Intake Record Tutorial has already 

been completed.   

 

The DSAM User Product Tutorial provides detailed instructions for creating a DSAM User Product 

project, entering a User Product, and resolving a missing product.  It will familiarize you with the 

User Product feature in NDSR.  This tutorial assumes that the Intake Record Tutorial has already 

been completed.   

 

As you move through the tutorials, notice the microhelp in the lower left corner of your screen.  

Details about the active area of a window (the field that has focus) are provided as well as other 

helpful information.  Tips about the database, the interview system and the multiple-pass approach 

to collecting dietary recalls are provided in italics to increase your awareness of NDSR features. 

 

Interview prompts are provided to aid in standardizing collection of 24-hour dietary and supplement 

intakes and are imbedded in the program windows.  Transitional prompts appear in pop-up 

windows.  The interview prompts that appear on NDSR windows, especially during food search, are 

suggestions and may need to be rephrased at times.  At other times, you will need to formulate a 

question based on the information NDSR needs.  If you will be entering recalls directly into NDSR, 

practice using these prompts out loud.  Refer to “Appendix 13, Multiple-pass Approach” for more 

information about interview prompts.   

 

Once you have completed the tutorials, take some time to explore the program.  Tab through the 

various windows and look at the options in the drop-down lists.  If you have questions as you work 

with the program, you can refer to the NDSR User Manual, email ndsrhelp@umn.edu, or call NCC 

at 612-626-9450 or for assistance.   

 

 

 

 

 

 

mailto:ndsrhelp@umn.edu
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Intake Record Tutorial 
Starting NDSR 
After you have installed NDSR on your computer, you are ready to start the program.  The 

following steps describe how to start, or access, NDSR. 

 

1. Select Start→NDSR 2025→NDSR 2025. 

 

2. Receive the Nutrition Data System for Research logo window. 

 

3. When your computer has accessed the NDSR application, you receive the Folder, Project 

and Record Selection window. 

 

Creating an Intake Project 
Before you can enter an intake day into NDSR, you must create a project to organize the records 

and select the record type for the project. 

 

NOTE: Your project is stored in the Main Folder.  Subsequent folders may be created to help 

organize your NDSR projects but are not required by NDSR. 

 

The following steps describe how to create a project.  Try using the keyboard shortcuts that are in 

parentheses (ALT + the underlined letter) 

 

1. Select Project→New (ALT + W). 

 

2. When you receive the Project Information window, type Tutorial – Dietary 
Recalls in the Project Name: field (TAB to next field). 

 

3. Type Tutorial in the Project Abbreviation: field (TAB to next field). 

 

4. Select RECALL from the drop-down list in the Record Type: field.  Press ALT + down 

arrow (↓).  Arrow down to highlight RECALL (TAB to next field). 

 

5. Select the Dietary Supplement Assessment Module radio button: 24-HOUR AND PAST 30 

DAYS INTAKE (ALT + 3) (TAB to next field). 

 

6. Type “Text entered as a note on the Project Information window 
will be included in the Project List Report” in the Notes: field. 

 

7. Select the ENTER key to open the Preferences window or select the PREFERENCES button 

(ALT + P) on the Project Information window. 
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Setting Project Preferences 
NDSR allows you to customize a project to reflect study protocol by providing preference 

selections.  Method Preferences define the Header tab and Trailer tab display, and food-entry 

requirements.  Customizable Header and Trailer Preferences specify additional information that can 

be collected for the Header and/or Trailer tab. Customizable Meal and Food Preferences specify 

additional information that can be collected for the Meal and/or Food. Dietary Supplements 

Preferences specify the requirement of additional supplement use questions.  Project Preferences 

define the location of Backup, Export, Output, and Reports folders, and Introduction File Name 

location.  User Preferences allow you to use theme colors, select the degree of shading in the 

Choose Description pane of the Food Search window, and to include column headers in output 

files. 

 

1. Receive the Preferences window.  On the Method tab, TAB from field to field until the 

SHOW NON-REQUIRED FIELDS IN RECORD HEADER has focus. 

 

2. Select SHOW NON-REQUIRED FIELDS IN RECORD HEADER (SPACE BAR).  Continue to 

TAB until USE FORGOTTEN FOOD PASS has focus.  Select USE FORGOTTEN FOOD PASS 

(SPACE BAR).   

 

3. Continue to TAB until the focus is back on the Method tab.  Select the Customizable 

Header & Trailer tab (Right arrow →).  TAB once until the cursor appears in the Header 
Data Field 1: field.  Type “Tutorial Descriptor 1”.  TAB once to the 

CHARACTER LIMIT field and type “1”.  TAB once so REQUIRE checkbox is in focus and 

press SPACE BAR to select. TAB once to Header Data Field 2: field. Type 

“Tutorial Descriptor 2”.  TAB three times to Header Data Field 3: field. 

Type “Tutorial Descriptor 3”.  TAB until the cursor appears in the Trailer 
Data Field 1: field.  Type “Rate satiety level”.  TAB twice so REQUIRE 

checkbox is in focus and press SPACE BAR to select.  Continue to TAB until the focus is 

back on the Customizable Header & Trailer tab. 

     

4. Select the Customizable Meal & Food tab (Right arrow →). View the option to customize 

additional data fields at the Meal and Food levels, but do not enter anything. (For more 

information about how to utilize these fields, see Chapter 3 of the User Manual.)   

 

5. Select the Dietary Supplements tab (Right arrow →).  On the Dietary Supplements tab, 

TAB to REASON FOR USE.  Press SPACE BAR to select.  Continue to tab until the focus is 

back on the Dietary Supplements tab. 

 

6. Select the Project tab (Right arrow →).  View default settings.  

 

7. Select the User tab (Right arrow →).  View default settings. 

 

Column Headers in Output Files: The ‘Include column headers in output files’ check box in the User 

Preferences allows you to indicate whether or not you want column headers to be included in the output 

files.  Choose the preference setting depending on the specifications of the program you intend to use for 

analysis of your data.  For example, spreadsheet programs like Excel work better with headers. Analysis 

programs like SAS may work better without headers.     

 

8. Select the OK button (ENTER). 

 

9. Receive the Project Information window.  Select the OK button (ENTER). 
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Creating an Intake Record 
After you have created a project and set preferences, you can create records within that project.  The 

following steps describe how to create a record. 

 

1. Select Record→New (ALT + N). 

 

2. When you receive the Record Information window, complete the fields on the Header tab 

using the following information (TAB to move to the next field, SHIFT + TAB to move back 

a field). 

 

Field Name Entry 

Participant ID: 123456789abc 

Date of Intake: Yesterday’s date (NDSR will automatically assign this) 

Participant Name: PTS 

Date of Birth: 02021950 

Sex: F 

Life Stage Group: Females, age over 70 y (NDSR will select this) 

Interviewer ID: A12 

Visit Number: 1 

Site ID: 2 

Tutorial Descriptor 
1: Y 

Tutorial Descriptor 
2: 
 
 

Max 100 characters can be entered in Customized 
Header if no character limit set in Preferences 

Tutorial Descriptor 
3: 
 
 

These customizable fields will be included in 
Output Files 04-06 and the Record Properties 
Report 

Notes:  
 
 

Up to 600 characters entered in the Notes: field 
will be included on the Record Properties Report 
and Daily Intake Totals Output File (File 04) 

 

Required Field: Notice how the Participant Name: field is not required (not yellowed) per project 

preferences set earlier.  Entering the initials of the participant provides a cross-check on the participant ID.  

Also note that the Date of Entry (today’s date) and Date of Intake (yesterday’s date) are 

entered for you but can be changed if needed by retyping the desired date.  Note that Tutorial 
Descriptor 1: field is required while Tutorial Descriptor 2: field and Tutorial 
Descriptor 3: field are not. The NDSR Database Version is also included on the Header tab. 

 

3. When you have finished entering header information, select the CONTINUE RECALL button 

(ALT + I). 
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Entering an Intake Record 
This section of the tutorial covers entering a complete record for one participant using the Quick 

List, Meal Information, Add Food, and Food Search windows.  You will enter amount details 

using the Item Detail pane for the Food Detail window, and you will be prompted for preparation 

detail using the Select Variables window. 

 

Introduction Script: A standard introduction script will appear if selected on the Method tab.  The 

Introduction Script can be customized to meet the needs of the study.  See “Setting User Preferences” in 

Chapter 3 for more information.  Press ENTER or select OK to close the Introduction Script.   

 

Entering Foods in the Quick List Window 
On the Quick List window, first notice the interview prompts.  During the first pass you will type 

the information the participant gives you, listing the foods and beverages that the participant 

consumed for each meal or snack during a specified time period (usually 24-hours).  Descriptive 

food detail is not entered in this window.  Time of day (and possibly meal name/meal location if the 

information is offered by the participant) is entered on one line and foods are entered on subsequent 

lines.  Notice that all eating occasions must begin with a slash (/) followed by the time, and that 

there are no spaces within the time (e.g., /7:00pm or /7p).  The slash (/) may be accessed by typing 

or by pressing ENTER twice.  

 

Follow these steps to enter foods in the Quick List window: 

 

1. Type the information listed below into the Quick List window. 

 

NOTE: Make sure you type the information exactly as it appears in the table.  Several 

examples of meal times, meal names, and eating occasions have been provided for 

you. 

 

Type: And Press: 

/8a breakfast home ENTER 

coffee ENTER 

cheerios ENTER  TWICE 

/10a snack work ENTER 

granola bar ENTER TWICE 

/1230p lunch work ENTER 

diet coke ENTER 

chicken sandwich ENTER 

raw veggies ENTER 

cheetos ENTER TWICE 

/5p snack ENTER 

pizza ENTER 

ice cream bar ENTER TWICE 

(Continued on next page)  
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/7:00pm ENTER 

lasagna ENTER 

tossed salad ENTER 

garlic bread ENTER 

Wine ENTER TWICE 

/9:00p snack ENTER 

low calorie key lime pie ENTER 

tap water, consumed throughout the day  

 

Quick List: You may have noticed that the first slash (/) is provided for you on the Quick List window.  A 

slash is necessary to separate the eating occasions.  The text (names of foods and beverages) entered on the 

Quick List initiates the food search process and provides a valuable record of the information as reported 

by the participant which may help avoid repeating a question later.   

 

2. When you have entered all the foods in the Quick List window, select the VERIFY button 

(ALT + I). 

 

3. A Quick List Review Prompts window will appear. 

 

4. Using the Quick List Review Prompts, review the Quick List entries (SHIFT + TAB to 

return to the Quick List window).  Use the up or down arrows to position your cursor to 

correct any errors you see.  This review (completed with the participant) is the second pass 

of the dietary interview. 

 

NOTE: You may find it necessary to resize your window so all the prompts are visible. 

 

Quick List Review: This opportunity can be used to identify and add forgotten foods (e.g., beverages, 

snack foods).  Also look for gaps in time which may indicate missed meals or snacks.  This is the second 

pass in the multiple-pass approach to collecting dietary data. 

 

5. When you have verified all Quick List entries, select the CONTINUE> button (ALT + I). 

 

6. An interview prompt will appear.  Read the prompt and then select the OK button to move 

on to the third pass of the interview (ENTER). 

 

Entering Food Detail 
Follow these steps to enter food detail: 

 

1. When you receive the Meal Information window, review the information and correct any 

errors. 

 

2. When you have verified all meal information, select the CONTINUE> button (ALT + I). 

 

3. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the coffee?”  Select the CONTINUE> button to start the food search for 

the coffee (no additions) (ALT + I). 
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Additions: Ask about additions to every food and until a “no” response is received, as more than one item 

may have been added.  “Additions” include items that have been added after the food or beverage has been 

prepared or when at the table.  Using this feature permits grouping of foods eaten together, information that 

may be important during quality assurance and final analysis. 

 

4. When you receive the Food Search window, describe the coffee: 

a. Choose coffee (ENTER). 

 

b. Choose regular (caffeinated) (ENTER). 

 

c. Choose made from ground (ENTER). 

 

d. When you receive the Food Detail window, notice the prompt: “How much did you 

eat (drink)?”  The participant may report “a cup” and the interviewer should 

determine the size of the cup and the amount consumed.  Use the Item Detail pane 

to describe the amount of coffee using the following information: 

• Unit: CP – cup (Type CP or view unit list by using ALT + down 

arrow (↓) to select cup) (TAB to next field) 

• Quantity: 1 (TAB to next field) 

 

Reference Amounts: Notice that after you tab to the Notes: field, the amount 8.00 FO appears in 

parentheses to the right of the 1 CP amount that was entered.  Viewing the reference amounts after entering 

each quantity by tabbing to the Notes: field can help the interviewer and/or the participant visualize the 

portion size in another way.  The unit of the reference amounts will vary depending on the food selected.   

 

e. Select the CONTINUE> button to go to the next food (ALT + I). 

 

5. The next food from the Quick List is Cheerios®.  When you receive the Add Food window, 

notice the prompt, “Did you add anything to the Cheerios®?” 

a. Select the Additions pane (TAB). 

 

b. Type skim milk and press the ENTER key. 

 

c. Repeat the question “Did you add anything else?” until the participant responds 

with “no”.  This food has only one addition. 

 

d. Select the CONTINUE> button to begin the food search for Cheerios® (ALT + I). 

 

6. When you receive the list of Cheerios®, describe them: 

a. Choose Frosted Cheerios (General Mills) from the list (arrow down 

(↓) until the food is highlighted, then press ENTER to select). 

 

b. Describe the amount of Cheerios® using the following information: 

• Unit: CP – cup (Type CP or view unit list by using ALT + down 

arrow (↓) to select cup) (TAB to next field) 

• Quantity: 1 ¼ (TAB) 
 

Quantity: Quantities may be entered as integers, fractions, or decimals.  NDSR will convert fractions to 

decimals. 

 

c. Select the CONTINUE> button to begin the food search for the skim milk (ALT + I). 
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7. When you receive milk, skim, nonfat or fat free select this item by pressing 

ENTER. 

a. Describe the amount of milk, using the following information: (As previously 

stated, TAB between fields) 

• Unit: FO – fluid ounce 
• Quantity: 6 (TAB) 

 

Amounts: While you are generally asking the participant for a record of their intake (e.g., what they ate 

and drank that day) it is important to confirm that they are describing the amount eaten, not the amount 

served.  Additional probes to confirm amounts include: “Did you eat/drink all the milk on your cereal?” 

“Were you able to finish that sandwich?” 

 

b. Select the CONTINUE> button to go to the next meal (ALT + I). 

 

8. When you receive the Meal Information window, review the information that appears and 

correct any errors.  Select the CONTINUE> button (ALT + I). 

 

9. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the granola bar?”  Select the CONTINUE> button to start food search for 

the granola bar (no additions) (ALT + I). 

 

10. Describe the granola bar: 

a. Choose: granola bars. 

 

b. Notice the interview prompt: “What brand or type of granola bars was it?”  The 

participant reports Clif Bar® Chocolate Brownie. 
 

c. Choose: brand name listing. 
 

Brand Name Listing: The interview prompt “What brand or type of granola bars was it?” is your cue to 

determine if this food can be entered as a specific brand or as an NDSR non-brand (generic) granola bar.  

When the participant reports a product that carries the name of a grocery store chain (e.g., Albertsons®), a 

store brand (e.g., Best Yet®), or does not know the specific brand, have the participant describe the item in 

detail.  Select an appropriate NDSR non-brand granola bar or enter it as a missing food and decide later if it 

meets the missing food criteria as explained in “Appendix 8, Missing Foods and DSAM Products” or 

matches a generic entry.   

 

d. Limit the brand name search by selecting the Limit To: field (ALT + L or TAB).  

Type cl in the Limit To: field. 

 

e. Select: Clif Bar – Chocolate Brownie (SHIFT + TAB to return to the 

Choose Description pane, arrow down (↓) until the food is highlighted, then press 

ENTER to select). 

 

Limit To: This feature restricts the search to include the beginning of any word or words in a Food 

Description or Category.  Notice how the list of the foods displayed in the Choose Description pane 

includes only the granola bars that have words in the name beginning with the letters cl. 

 

f. Describe the amount of Clif Bar® Chocolate Brownie using the following 

information: (TAB between fields, ALT + ↓ to view unit options, TAB to select from 

list) 

• Unit: REB – regular size bar - each 2.4 OZ 
• Quantity: 1 (TAB) 
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g. Select the CONTINUE> button to go to the next meal (ALT + I) 

 

11. When you receive the Meal Information window, review the information that appears and 

correct any errors.  Select the CONTINUE> button (ALT + I). 

12. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the Diet Coke®?”  Select the CONTINUE> button to start food search for 

the Diet Coke® (no additions) (ALT + I). 

 

13. When you receive the list of Diet Coke® types, describe the Coke®: 

a. Choose Coke – diet, fountain from the list (arrow down (↓) until the food 

is highlighted, then press ENTER to select). 

 

Database Specificity: Some brands of diet fountain soda have a different nutrient profile than bottled or 

canned diet soda because a different type of artificial sweetener is used. 

 

b. Describe the amount of Coke® using the following information: (TAB between 

fields, ALT + ↓ to view the ice options, arrow down (↓) to highlight, TAB to select 

from list) 

• Unit: FO – fluid ounces 
• Quantity: 16 
• Ice: with ice (crushed or cubed) (TAB) 

 

Ice Field: If a beverage is reported using a volume measure (e.g., cups, fluid ounces) and the amount 

includes ice, NDSR reduces the amount of the beverage to account for the ice in the total volume measure.  

The converted amount is included in parenthesis following the amount entered in the Foods/Additions 

pane on the left side of the Food Detail window after you press the TAB key from the Ice Field on this 

food.  You will not be prompted for Ice Field information when the amount is described using a Food 

Specific Unit (e.g., can or bottle) because the overall amount of beverage consumed is not changed by the 

presence of ice.  No ice prompts are provided for milk or most coffee beverages.  See “Appendix 16, Raw-

to-cooked and Other Amount Conversions” for information about this and other amount conversions. 

 

c. Select the CONTINUE> button to go to the next food (ALT + I). 

 

14. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the chicken sandwich?”  Specify the components of the chicken 

sandwich (no additions): 

a. Select the ASSEMBLED FOOD OR RECIPE checkbox (ALT + R). 

• Notice a Components/Ingredients pane becomes available with a specific 

prompt: “What were the items in the chicken sandwich?” 

 

b. Select the Components/Ingredients pane (TAB). 

 

c. Type chicken and press the ENTER key. 

 

d. Type mayo and press the ENTER key. 

 

e. Type wheat roll on the next line. 

 

Additions to an Assembled Food or Recipe: The Assembled Food or Recipe feature allows you to enter a 

fraction of a serving eaten and will automatically divide the items in the Components/Ingredients pane (e.g., 

1 sandwich is made, only ½ is eaten).  Anything added to the Additions pane will not be divided.   
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15. After you have typed the components of the Assembled Food or Recipe, select the 

CONTINUE> button and begin the search for the chicken. 

 

 

16. Describe the chicken in the chicken sandwich: (arrow down (↓) until the appropriate food or 

description is highlighted, then press ENTER to select). 

a. Choose chicken from the list. 

 

b. Describe the chicken, choosing the following information: 

• breast  
• skin removed before cooking 

 

c. When you receive the Select Variables window choose: 

• broiled or grilled or rotisserie 
• basted with added fat 
• fat used in basting or browning – unknown – 
prepared at home 

• no salt added 
 

Preparation Variables: NDSR probes for preparation methods (e.g., fried, baked, steamed) and 

ingredients.  This feature allows you to more specifically describe the fat and sodium content of the food. 

 

d. Describe the amount: (TAB between fields) 

• Unit: MD – medium – split 
• Quantity: 1 (TAB) 
 

e. Select the CONTINUE> button to start the food search for the mayo (ALT + I). 

 

17. Describe the mayo: 

a. Choose the following information from the lists: 

• mayonnaise or mayo type dressing 

• brand name listing 
• Kraft Light Mayonnaise 

 

b. Describe the amount of Kraft™ Light Mayonnaise using the following information: 

(TAB between fields) 

• Unit: TB – tablespoon 
• Quantity: 1 (TAB) 

 

c. Select the CONTINUE> button to go to the wheat roll (ALT + I). 

 

18. Describe the wheat roll: 

a. Choose rolls, cracked wheat 

 

Database Information: Many different types of “wheat rolls” are available in the NDSR database (e.g., 

whole wheat, cracked wheat), and many varieties of “rolls or buns” (e.g., hamburger buns, hotdog buns, 

submarine rolls, dinner rolls).  Detailed questions for the participant will help to identify the exact type of 

roll consumed.  Each variety of roll has a unique definition for the common size FSU (Food Specific Unit) 

description (e.g., large, medium, small).  Verify the dimensions of the size reported by participant (e.g., 

“This roll is about the size of a regular hamburger bun – does that sound about right?”).  Being familiar 

with the size of common food can be beneficial when offering help to the participant.   

 

b. Describe the amount: (TAB between fields) 
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• Unit: LG – large – 3 ½” diameter 
• Quantity: 1 (TAB) 

 

c. TAB to complete the amount entry. 

d. Select the CONTINUE> button (ALT + I). 

 

19. On the Item Detail pane, describe the Assembled Food or Recipe amount and serving size: 

a. Confirm the number of servings using the following information: (TAB between 

fields) 

 

b. Servings Made: 1 
 

c. Confirm that the participant consumed the entire sandwich by saying “Were you 

able to finish the sandwich?” 

 

d. TAB to Servings Eaten:  and change amount to ½. 

 

e. TAB to Serving Size Description and type: 1 sandwich 

 

Assembled Food or Recipe Feature: NDSR uses defaults of 1 serving made, 1 serving eaten.  This 

example describes the entire sandwich as 1 serving made and ½ serving eaten to show how NDSR 

automatically calculates the nutrients based on the amount consumed (the number of servings eaten).  For 

this dietary recall, nutrients will be calculated for ½ of a sandwich.  The servings made and eaten is asked 

after the entry of the component/ingredients for Recalls and Record Assisted Recalls, but before the 

component/ingredient entry for Records.  The Serving size description field is optional and is not part of 

the nutrient calculation.  It is a note field that can be used to describe the yield or the portion consumed. 

 

NCC Food Group Serving Count System Information: NCC Food Group Serving Count Subgroups are 

automatically assigned per component/ingredient.  Assembled Foods or Recipes may be reassigned to one 

of 174 subgroups.  Foods like sandwiches do not fit a single subgroup, but the components contribute to 

the grain, meat, vegetable, etc. 

 

f. Select the CONTINUE> button to go to the next food (ALT + I). 

 

20. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the raw veggies?”  Specify the components of the raw veggies:  

a. Select the ASSEMBLED FOOD OR RECIPE checkbox (ALT + R). 

 

b. Select the Components/Ingredients pane (TAB). 

 

c. Type broccoli and press the ENTER key. 

 

d. Type cauliflower and press the ENTER key. 

 

e. Type carrots on the next line. 

 

f. Select the Additions pane (TAB). 

 

g. Type dip and select the CONTINUE> button (ALT + I). 

 

21. When you receive the Food Search window, describe the broccoli: 

a. Choose the following information: 

• broccoli 
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• raw 
 

b. Describe the amount of broccoli using the following information: (TAB between 

fields) 

• Unit: FL – flower 
• Quantity: 3 (TAB) 

 

c. Select the CONTINUE> button to go to the cauliflower (ALT + I). 

 

22. When you receive the Food Search window, describe the cauliflower: 

a. Choose the following information: 

• cauliflower 
• raw 

 

b. Describe the amount of cauliflower using the following information: (TAB between 

fields) 

• Unit: FL – flower 
• Quantity: 3 (TAB) 

 

Food Specific Units (FSU): While both the cauliflower and the broccoli have a common FSU of “flower”, 

each vegetable will have its own specific weight for a flower.  See “Appendix 6, Measurement 

Abbreviations” for a list of other Food Specific Units. 

 

c. Select the CONTINUE> button to go to the carrots (ALT + I). 

 

23. When you receive the Food Search window, describe the carrots:  

a. Choose the following information: 

• carrots 
• raw 

 

b. Describe the amount of carrots using the following information: (TAB between 

fields) 

• Unit: MBB – medium baby 
• Quantity: 3 (TAB) 

 

c. Select the CONTINUE> button to go to the dip (ALT + I) 

 

24. On the Item Detail pane, confirm the Assembled Food or Recipe amount and serving size: 

a. Confirm the number of servings using the following information: (TAB between 

fields) 

• Servings Made: 1 
• Servings Eaten: 1 
• Serving Size Description: leave blank 
 

b. Select the CONTINUE> button (ALT + I) 

 

25. When you receive the Food Search window, describe the dip: (arrow down (↓) until the 

desired food or description is highlighted, then press ENTER to select) 

a. Choose the following information: 

• dips 
• sour cream (seasoned) 
• commercial 
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• regular 
 

b. Describe the amount of dip using the following information: (TAB between fields) 

• Unit: TS – teaspoon 
• Quantity: 9 (TAB) 
 

c. TAB to complete the amount entry. 

 

d. Select the CONTINUE> button to go to the next food (ALT + I). 

 

Additions to Assembled Foods: Amounts of the components/ingredients within an Assembled Food or 

Recipe are adjusted according to the number of servings made and the number of servings eaten.  This 

adjustment is not made for items entered on the Additions pane of the Add Food window. 

 

26. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the Cheetos®?”  Select the CONTINUE> button to start the food search 

for the Cheetos® (no additions) (ALT + I). 

 

27. When you receive the list of Cheetos, choose the type of Cheetos® from the list: (arrow 

down (↓) until the food is highlighted, then press ENTER to select) 

a. Choose Cheetos Crunchy 

 

b. Describe the amount of chips using the following information: (TAB between fields) 

• Unit: BAG – bag – single serving – each 1 OZ 
• Quantity: 1 (TAB) 

 

Food Specific Units: Note this bag is the small, single serving bag and that there is a grab bag option 

available.  Most snacks are available in several bag sizes.  Always confirm the bag size with the participant 

when using the FSU.  Use weight, volume, or number of pieces to describe an amount of snack chips.  Had 

you entered other amounts, you could see per the reference amount for this food that 1 cup weighs about 1 

¼ ounces and 21 pieces weigh 1 ounce.  Because snack chips differ in their density, each type will have a 

different weight per cup or piece.   

 

c. Select the CONTINUE> button to go to the next meal (ALT + I). 

 

28. When you receive the Meal Information window describe the snack:  

a. Select DELI/TAKE-OUT/STORE from the drop-down list in the Location: field 

(ALT + ↓ to view options, TAB to select). 

 

b. Select CONTINUE> to proceed with the next food (ALT + I). 

 

29. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the pizza?”  Select the CONTINUE> button to start the food search for 

the pizza (no additions) (ALT + I). 

 

30. Describe the pizza: (arrow down (↓) until the food or description is highlighted, then press 

ENTER to select) 

a. Choose the following information: 

• pizza 
• frozen 
• with meat and vegetables (e.g. sausage, pepperoni, 
or hamburger) 

• thin crust 
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• wheat crust 
 

Database Specificity: Frozen pizza was selected because the participant stated that it was a sample at a 

grocery store.  While frozen pizza is not listed by brand name in NDSR, many national fast food pizza 

restaurant brands are included in NDSR.  Search the fast food hierarchy (FAST) for a list of fast food pizza 

restaurants in NDSR (e.g., Domino’s®, Little Caesars®, Papa John’s®, Pizza Hut®). 

 

b. Describe the amount of pizza using the following information: (TAB between fields) 

• Unit: REC – rectangle 
• Dimensions Unit: IN – inch 
• Length: 2 
• Width: 2 
• Quantity: 1 (TAB) 

 

c. TAB to complete the amount entry. 

 

Food Specific Units: Note that the FSU’s for pizza indicate the size of the entire pizza and include the 

diameter in the description.  Select the closet diameter or size of the pizza and enter the fraction eaten or 

select a food shape listed as an NDSR option such as the rectangular piece of pizza described above.   

 

31. When you receive the Amount Minimum Check window, confirm with the participant that 

the amount entered is correct.  Select OK to return to the notes on the Item Detail pane 

(ENTER).   

a. In the Notes: field type “2” x 2” piece, sample at grocery 
store.” 

 

b. Select the CONTINUE> button to go to the next food (ALT + I). 

 

Amount Minimum Check: This check alerts you to a very small amount of food which may be real or the 

result of a data entry error.  Amount minimum and amount maximum checks will always display in intake 

records, but preferences When the preferences are set to invoke this check, a note is required to confirm.  

The piece of pizza entered above is equivalent to 0.04 of a 12” diameter pizza (see the reference amount 

information in parentheses following the amount entered).  Check the accuracy of your data entry and/or 

confirm the amount entered with the participant.  If the amount is correct, the note provides documentation 

for the data entered. 

 

32. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the ice cream bar?”  Select the CONTINUE> button to start the food 

search for the ice cream bar (no additions) (ALT + I). 

 

33. Note the prompt: What brand or type of ice cream bar was it?  The participant’s response 

“low fat, low calorie chocolate covered ice cream bar” determines 

your choices.  Describe the ice cream bar: 

a. Choose the following information: 

• ice cream bar 
• reduced fat and no sugar added (e.g. Klondike) 

 

b. Describe the amount of ice cream bar using the following information: (TAB 

between fields) 

• Unit: BAR – bar - each 4 FO 
• Quantity: 1 (TAB) 

 

c. Select the CONTINUE> button to go to the next meal (ALT + I). 
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34. When you receive the Meal Information window, describe the evening meal: (TAB to the 

next field, ALT + ↓ to view options, TAB to select) 

a. Select DINNER/SUPPER from the drop-down list in the Name: field. 

 

b. Select RESTAURANT/CAFETERIA/FAST FOOD from the drop-down list in the 

Location: field. 

 

c. Select CONTINUE> to proceed with the next food (ALT + I). 

 

35. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the lasagna?”  Select the CONTINUE> button to start the food search for 

the lasagna (no additions) (ALT + I). 

 

36. Describe the lasagna: (arrow down (↓) until the food or description is highlighted, then 

press ENTER to select). 

a. Choose the following information: 

• lasagna 
• from recipe 
• beef 

 

b. When you receive the Select Variables window describe the ingredients in the 

lasagna, choosing the following information: 

• hamburger - unknown % fat 
• lasagna noodles - unknown 
• ricotta cheese 
• unknown type 
• cheese 
• Mozzarella cheese 
• unknown type 
• salt - unknown if salt added 

 

NOTE:  The Ingredient: field box in the Select Variables For: window gives the name of 

the ingredient you are describing. 

 

Variable Ingredients: NDSR permits you to vary ingredients within a food when key nutrients are 

affected (e.g., type of ground beef, type of salt, and type of cheese are all variables for this food which 

would affect the fat, fatty acid, and sodium values for the food).  Even though this lasagna is consumed at a 

restaurant, the participant may know some basic ingredient information from the menu.  Select NDSR 

unknowns once the participant indicates that they do not know anything about the preparation. 

 

c. Describe the amount of lasagna using the following information: (TAB between 

fields) 

• Unit: REC – rectangle 
• Dimensions Unit: CM - centimeter 
• Length: 10 
• Width: 10 
• Quantity: 1 (TAB) 
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Units for entering food shapes: A default food shape dimension unit is a setting in the Method 

Preferences.  When “INCHES” is selected in Method Preferences, inches will be displayed in the Food 

Detail window.  If centimeters is preferred, select the radio button for “CENTIMETERS” in the Method 

Preferences. Regardless of which unit is selected as default in the preferences, the unit for the dimensions 

can be changed from inches to centimeters or centimeters to inches within the Food Detail window at the 

time of amount entry. 

 

NOTE: The reference amount in (parenthesis) for this entry of lasagna is equal to 1.28 cups.  The 

reference amount can be useful to confirm that the amount entered seems reasonable. 

 

d. Select the CONTINUE> button (ALT + I) to proceed with the next food. 

 

37. When you receive the Add Food window, ask the participant to tell you about the tossed 

salad in order to determine if a database salad is appropriate.  Notice the prompt in the 

Additions pane: “Did you add anything to the tossed salad?”  Select the CONTINUE> button 

to start the food search for the tossed salad (no additions) (ALT + I). 

 

38. When you receive the Food Search window, describe the tossed salad: (arrow down (↓) 

until the food or description is highlighted, then press ENTER to select). 

a. Choose the following information: 

• tossed salad 
• with dressing 
• without tomatoes or carrots 
• without avocado, cheese or egg 

 

Database Specificity: The NDSR database includes a salad with and without dressing.  If the participant 

can tell you the amount of dressing, select the salad without dressing and add the salad dressing as an 

addition to this food. 

  

b. When you receive the Select Variables window describe the ingredients in the 

tossed salad, choosing the following information:  

• mixed greens 
• dressing for salads 
• French 
• unknown if commercial or homemade 
• unknown if regular, light, or fat free 

 

c. Describe the amount of salad using the following information: (TAB between fields) 

• Unit: CP – cup 
• Quantity: 2 (TAB) 

 

d. Select the CONTINUE> button to go to the next food (ALT + I). 

 

39. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the garlic bread?”  Select the CONTINUE> button to start the food 

search for the garlic bread (no additions) (ALT + I). 

 

40. Describe the garlic bread: 

a. Choose the following information: 

• garlic bread 
• with “butter” 
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Food Descriptions: When you see the quotation marks around a food name (e.g., “butter”), it means this 

food or a similar food is one of the ingredients in the food being selected.  For example, this garlic bread 

may have margarine instead of butter.  

 

b. When you receive the Select Variables window describe the ingredients in the 

garlic bread, choosing the following information:  

• fat used as seasoning – unknown type of fat used 
c. Describe the amount of bread using the following information: (TAB between 

fields) 

• Unit: MDS – medium slice 4” x 2 ½” x 1 ¾” 

• Quantity: 1 (TAB) 
d. Select the CONTINUE> button to go to the next food (ALT + I). 

 

41. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the wine?”  Select the CONTINUE> button to start the food search for 

the wine (no additions) (ALT + I). 

 

42. Describe the wine: 

a. Choose the following information from the list: 

• wine 
• other table (<15% alcohol) 
• red 

 

b. Describe the amount of wine using the following information: (TAB between fields) 

• Unit: FO – fluid ounce 
• Quantity: 6 (TAB) 

 

c. Select the CONTINUE> button (ALT + I). 

 

43. When you receive the Meal Information window, describe the snack: 

a. Select HOME from the drop-down list in the Location: field. 

 

b. Select the CONTINUE> button (ALT + I). 

 

44. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the low calorie key lime pie?”  Select the CONTINUE> button to start 

the food search for the low calorie key lime pie (no additions) (ALT + I). 

 

45. When you receive the Food Search window, the following message will appear:  

 

No foods found. 

- Check the spelling. 

- Revise the search text. 

- Select the EXPAND SEARCH button for a broader search. 

- Select the HIERARCHY button for a list of food categories. 

 

The description of “low calorie” provided by the participant during the quick list pass is 

problematic to this food search.  Type “key lime pie” into the Search by pane and 

press ENTER.  Then, ask the participant for more information based on the results (e.g., 

“Tell me more about the pie--was it purchased or made at home?”).  For this recall, the 

participant states that they had a store-bought Weight Watchers Key Lime Pie.  You can 

find this product by selecting the EXPAND SEARCH button (ALT + E) or by selecting 
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desserts – miscellaneous from the search results and then using the Limit 
To: field by typing in “weight watchers pie”.  

 

a. Choose desserts – miscellaneous, snacks – commercial 
packaged, brand name listing… from the list. 

 

b. TAB to the Limit To: field. 
 

c. Type pie.  The search is limited.  Select SHIFT + TAB to move to the previous field 

and arrow down (↓) to Weight Watchers Smart Ones Key Lime Pie. 

 

d. Press ENTER to select Weight Watchers Smart Ones Key Lime Pie. 

 

e. Describe the amount using the following information: (TAB between field) 

• Unit: PIE pie – each 2.9 OZ 
• Quantity: 1 (TAB) 

 

f. Select the CONTINUE> button (ALT + I) to start the food search for the next food. 

 

46. When you receive the Add Food window, notice the prompt in the Additions pane: “Did 

you add anything to the tap water?”  Select the CONTINUE> button to start the food search 

for tap water (no additions) (ALT + I). 

 

47. Describe the tap water: 

a. Choose water – tap 

 

b. Describe the amount of water using the following information: (TAB between 

fields) 

• Unit: QT - quart 
• Quantity: 1 
• Ice: without ice (TAB) 

 

c. TAB to Notes: field.  Type “consumed throughout the day”. 

 

d. Select PRIORITY NOTE checkbox (ALT + Y). 

 

e. Select the CONTINUE> button (ALT + I). 

 

Priority Note: A note flagged as a Priority Note alerts the dietary interviewer or quality assurance staff 

that an item may need further attention after the interview is completed.  In this case, the investigators may 

want the beverage split into several eating occasions vs. appearing as if consumed all at one time.  See 

“Appendix 12, Protocol Considerations and Quality Assurance” for more information about Priority Notes. 

 

48. A Forgotten Foods window will appear.  Read the appropriate prompts and edit the Record 

as necessary on the Food tab.  Arrow down to the appropriate place to add meals or foods.  

NDSR will insert a food or meal above the line that is highlighted.  When edits have been 

completed, select CONTINUE RECALL> button (ALT + I). 

 

Forgotten Foods: This is a preference setting that must be selected on the Project tab.  The Forgotten 

Foods Pass provides prompts to get the participant thinking about some commonly forgotten foods when 

doing a recall.  The interviewer can read any or all questions relevant to their study and can continue to edit 

the recall if necessary.   
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49. An interview prompt will appear.  Read the prompt and then select the OK button to proceed 

with the next pass of dietary portion of the recall (ENTER). 

 

50. On the Food tab, review the information you’ve entered with the participant, making any 

changes as needed if new information is revealed. 

 

Final Review Probing: It is important to continue to engage the participant in the recall process as you 

complete the final review as important information about the intake may be revealed.  Open the Final 

Review Prompts (ALT + P) for help with this review. 

 

Our participant now recalls that she consumed two cups of coffee, each closer to 10 fluid ounces, that there 

were two slices of tomato added to her sandwich, she had a portion of her eating companion’s steak at 

dinner, and that the wine she had was merlot.   

 

To edit when the Final Review Prompts are open, TAB until the first Meal Information line has focus and 

then arrow down.   

 

51. On the Food tab, select coffee, regular (caffeinated), made from 
ground (highlight, ENTER). 

a. When you receive the Food Detail window, Change the amount to: 

• Unit: FO – fluid ounce 
• Quantity: 20 (TAB) 

 

Amount Confirmation: Always confirm with the participant the understanding of 1 cup.  Do they mean 1 

standard measuring cup or as in the case of this coffee, a larger cup?  Use amount estimation tools to assist 

with this task.  See “Appendix 12, Protocol Considerations and Quality Assurance”. 

 

b. Select the CONTINUE> button (ALT + I). 

 

52. Select the chicken sandwich (highlight, ENTER). 

a. When you receive the Food Detail window, select the ADD FOOD button below to 

open the Add Food window with the Components/Ingredients and Additions 

panes (ALT + A). 

 

b. Add a tomato slice to the Components/Ingredients pane for the sandwich. 

 

c. Type tomato and select the CONTINUE> button.  Proceed to select the following: 

• tomato 
• raw 
• Unit: MDS – medium slice – ¼” thick 
• Quantity: 2 (TAB) 

 

Food Specific Units: Be sure to select the FSU that best matches the food eaten.  NDSR has FSU options 

for MDS (medium slice of tomato) and MD (medium whole tomato). 

 

d. Select the CONTINUE> button (ALT + I). 

 

53. Highlight the 7pm meal.  Select INSERT FOOD button (ALT + T).  Receive the Add Food 

window, type t-bone steak in the Name: field. Notice the prompt in the Additions 

pane: “Did you add anything to this food?”  Select the CONTINUE> button to start the food 

search for t-bone steak (no additions) (ALT + I). 

a. Choose the following: 

• steak – beef, t-bone 
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• no visible fat eaten 
• unknown preparation 
 

b. Enter the following amount information (TAB after each field). 

• Unit: OZ – ounce 
• Quantity: 4 
• Cooked: before cooking 
• Refuse: with refuse 
 

Amount Information: The participant reports eating about ¼ of the T-bone steak, with a menu weight of 

16 ounces.  Select weight before cooking when the participant reports “menu weight”.  For this steak, the 

weight includes refuse (the bone).  Note the actual amount eaten (2.20 ounces) appears on the 

Foods/Additions pane after you select the last amount detail and press TAB.   

 

c. Select the CONTINUE> button (ALT + I). 

 

54. Select the wine (highlight, ENTER). 

a. When you receive the Food Detail window, select the CHANGE FOOD button (ALT 

+ O).  Note the message “Discard the current food and search for another?” 

 

b. Select YES and type merlot in the Search by pane as the participant has now 

recalled the name of the wine. 

• wine, merlot 
• red 

 

Discard a Food: Note that the amount and quantity from the food discarded may be retained by NDSR.  

Confirm if it still applies to the new food. 

 

c. Select the CONTINUE> button (ALT + I) to return to the Food tab. 

 

d. Select the CONTINUE RECALL> button (ALT + I). 

 

Entering Trailer Information 
The Trailer tab captures information about the amount of food the participant reported and whether 

or not the record information is reliable. 

 

When you receive the Trailer tab, read the first prompt to describe the intake: 

1. Select the CLOSE TO THE AMOUNT THAT YOU USUALLY EAT? radio button (ALT + E). 

 

2. TAB to the Information was: field and choose the RELIABLE radio button (ALT + L).  

You may determine the response to this question without consulting the participant. 

 

3. TAB to the Rate satiety level: field and type “very satiated”.  

 

4. Select the CONTINUE RECALL> button (ALT + I). 

 

NOTE: If you do not select CLOSE TO THE AMOUNT THAT YOU USUALLY EAT? and 

RELIABLE, you must write an explanatory note to document the reason why the record 

should be considered unusual or unreliable.  Up to 600 characters entered into the 

Notes: field will appear in the Record Properties report and Daily Intake Totals 

Output File. 
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Trailer Tab: Note that the amount of food and reliability questions on the Trailer tab are a preference on 

the Project Method tab.  NDSR default is to use both of these questions on the Record Trailer.     

 

Begin the Dietary Supplement Interview 
Once you have completed the Trailer tab, the Dietary Supplement Interview begins, based on the 

preferences selected earlier.  Screening questions are used to prompt the participant to recall dietary 

supplements taken. 

 

Dietary Supplements: Congress defined the term “dietary supplement” in the Dietary Supplement Health 

and Education Act (DSHEA) of 1994.  A dietary supplement is a product taken by mouth that contains a 

“dietary ingredient” intended to supplement the diet.  The “dietary ingredients” in these products may 

include: vitamins, minerals, herbs or other botanicals, amino acids, and substances such as enzymes, organ 

tissues, glandulars, and metabolites.  Dietary supplements can also be extracts or concentrates, and may be 

found in many forms such as tablets, capsules, softgels, gelcaps, liquids, or powders.  They can also be in 

other forms, such as a bar, but if they are, information on their label must not represent the product as a 

conventional food or a sole item of a meal or diet.  Whatever their form may be, DSHEA places dietary 

supplements in a special category under the general umbrella of “foods,” not drugs, and requires that every 

supplement be labeled a dietary supplement. 

 

Ask the Dietary Supplement Use Screening Questions 
Follow these steps to enter dietary supplements reported during Supplement Use Screening.   

 

Receive and read the prompt on the Dietary Supplement Interview window.  “Now I have questions 

about dietary supplements you took over the past 30 days.”  Select the CONTINUE> button (ALT + I). 

 

1. Read Supplement Use Screening Question 1. 

a. The participant reports taking Centrum and eye vitamins. 

 

b. Type Centrum.  Press ENTER. 

 

c. Type eye vitamins. 

 

d. Select the CONTINUE> button (ALT + I). 

 

2. Read Supplement Use Screening Question 2. 

a. The participant reports taking no amino acids. 

 

b. Select the CONTINUE> button (ALT + I). 

 

3. Read Supplement Use Screening Question 3. 

a. The participant reports taking no supplements containing oils or fatty acids. 

 

b. Select the CONTINUE> button (ALT + I). 

 

4. Read Supplement Use Screening Question 4. 

a. The participant reports taking Echinacea. 

 

b. Type Echinacea. 

 

c. Select the CONTINUE> button (ALT + I). 
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5. Read Supplement Use Screening Question 5. 

a. The participant reports taking no fiber supplements. 

 

b. Select the CONTINUE> button (ALT + I). 

 

6. Read Supplement Use Screening Question 6. 

a. The participant reports taking no other dietary supplements. 

 

b. Select the CONTINUE> button (ALT + I). 

 

7. Read Supplement Use Screening Question 7. 

a. The participant reports taking no over-the-counter antacids. 

 

b. Select the CONTINUE> button (ALT + I). 

 

Entering Supplement Detail 
Once you have completed the screening questions, the following questions require viewing the 

product labels.  This tier begins with asking the participant for the product containers. 

 

1. Receive the Collect Supplement Containers dialog box and read the prompt: 

a. “Now I’ll ask for detail about each of the products that you reported.  It will be 

helpful to have the containers for as many of these products as possible.  I can wait 

while you gather them.” 

 

b. Select the CONTINUE> button (ALT + I). 

 

2. Receive the Review Product Label dialog box and read the prompt: 

a. “You said you took Centrum in the past 30 days.  Do you have the container for this 

product?” 

 

b. TAB to the NO button. 

 

c. Press ENTER to select. 

 

3. Receive the Product Search window and read the prompt: 

a. “Please provide the complete name of the product.” 

 

b. The participant reports from memory that the complete name is Centrum Silver 

Women 50+®.   

 

c. TAB to the Product Name pane and arrow down (↓) to and highlight Centrum 
Silver Women 50+. 

 

d. Select the SELECT PRODUCT button (ALT + P). 

 

4. Receive the How Many Days window and read the prompt: 

a. “In the past 30 days, on how many days did you take this product?” 

 

b. Type 25 

 

c. Select the CONTINUE> button. 
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5. Receive the How Many Taken window and read the prompt: 

a. “On average about how many tablets did you take each day you used the product 

over the past 30 days?” 

 

b. Type 1 

 

c. Select the CONTINUE> button (ALT + I). 

 

6. Receive the How Long Taken window and read the prompt: 

a. “For how long have you been taking this product or a similar type of product?” 

 

b. Type 5 

 

c. Tab to move to the next field, ALT + ↓ to view unit options for length of time. 

 

d. Arrow down (↓) to YEARS and TAB to select from list. 

 

e. Select the CONTINUE> button (ALT + I). 

 

7. Receive the Taken Yesterday dialog box and read the prompt: 

a. “Did you take this product yesterday?” 

 

b. Select the NO button (ALT + N). 

 

8. Receive the Reason Taken window and read the prompt: 

a. “Why do you take this product?” 

 

b. Type “I don’t always have time to eat right” 

 

c. Select the CONTINUE> button (ALT + I) twice. 

 

9. Receive the Review Product Label window and read the prompt: 

a. “You said that you took eye vitamins in the past 30 days.  Do you have the 

container for this product?” 

 

b. Select the YES button (ENTER). 

 

10. Receive the Product Search window and read the prompt: 

a. “Please provide the complete name of the product.” 

 

b. The participant reports Macuvites®  

 

c. Type Macuvite to search the DSAM database. 

 

NOTE: The product Macuvite® is not in the database. 

 

d. Select the ENTER MISSING PRODUCT button (ALT + M). 

 

11. Receive the Missing Product Detail window and type the following information:  (TAB 

between fields) 

a. Product name: Macuvite Eye Care 
 
b. Serving size quantity: 2 
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c. Serving size unit: Tablet 
 
d. Manufacturer/distributor: Nature’s Blend 
 

e. Product information source: Bottle/label (Select from drop-

down list) (ALT + ↓) 

12. Select ADD INGREDIENT (ALT + A). 

 

13. Receive the Add Ingredients window and enter the following based on the Supplement 

Facts portion of the product label: 

 

Type: And Press: 

vitamin A, 14320 IU ENTER 

vitamin C, 226 mg ENTER 

vitamin E, 200 IU ENTER 

zinc, 34.8 mg ENTER 

copper, .8 mg  

 

Ingredient Entry for User Products: While ingredients can be added one at a time, you may find it more 

efficient to enter all of the ingredients from the product container at one time before proceeding.  The 

amount information can be entered on the Add Ingredients window along with the ingredient.  Use a 

comma to separate the ingredient name and the amount.  NDSR will prompt for additional information 

when needed.   

 

14. When you have entered all ingredients in the Add Ingredients window, select the 

CONTINUE> button (ALT + I). 

 

15. Receive the Missing Product Detail window.  Select the CONTINUE> button (ALT + I) to 

specify the vitamin A. 

a. When VITAMIN A appears in the Find: field, scroll down (↓) to the VITAMIN 
A.  Select OK (ENTER) to select. 

 

b. Confirm 14320 in the Quantity: field (TAB). 

 

c. Confirm IU in the Unit: field. 

 

d. Select the CONTINUE> button (ALT + I) to specify the next ingredient. 

 

e. When VITAMIN C appears in the Find: field, scroll down to the VITAMIN C 
(ASCORBIC ACID).  Select OK (ENTER) to select. 

 

f. Confirm 226 in the Quantity: field (TAB). 

 

g. Confirm mg in the Unit: field. 

 

h. Select the CONTINUE> button (ALT + I) to specify the next ingredient. 

 

i. When VITAMIN E appears in the Find: field, scroll down to the VITAMIN E.  

Select OK (ENTER) to select. 
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j. Confirm 200 in the Quantity: field (TAB). 

 

k. Confirm IU in the Unit: field. 

 

l. Select the CONTINUE> button (ALT + I) to specify the next ingredient. 

m. When ZINC appears in the Find: field, scroll down to the ZINC.  Select OK 

(ENTER) to select. 

 

n. Confirm 34.8 in the Quantity: field (TAB). 

 

o. Confirm mg in the Unit: field. 

 

p. Select the CONTINUE> button (ALT + I) to specify the next ingredient. 

 

q. When COPPER appears in the Find: field, scroll down to the COPPER.  Select OK 

(ENTER) to select. 

 

r. Confirm .8 in the Quantity: field. 

 

s. Confirm mg in the Unit: field. 

 

t. Select the CONTINUE> button (ALT + I). 

 

16. Receive the How Many Days window and read the prompt: 

a. “In the past 30 days, on how many days did you take this product?” 

 

b. Type 30 

 

c. Select the CONTINUE> button (ALT + I). 

 

17. Receive the How Many Taken window and read the prompt: 

a. “On average about how many tablets did you take each day you used the product 

over the past 30 days?” 

 

b. Type 4 

 

c. Select the CONTINUE> button (ALT + I). 

 

18. Receive the How Long Taken window and read the prompt: 

a. “For how long have you been taking this product or a similar type of product?” 

 

b. Type 3 

 

c. TAB to move to the next field, ALT + ↓ to view unit options for length of time. 

 

d. Arrow down to YEARS and TAB to select from list. 

 

e. Select the CONTINUE> button (ALT + I). 

 

19. Receive the Taken Yesterday dialog box and read the prompt: 

a. “Did you take this product yesterday?” 

 

b. Select the YES button (ENTER). 
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20. Receive the Number of Times Taken Yesterday window and read the prompt: 

a. “How many times did you take this product yesterday?” 

 

b. Type 2 

 

c. Select the CONTINUE> button (ALT + I). 

 

21. Receive the Number Taken window and read the prompt: 

a. “How many tablets did you take the first time you used the product yesterday?” 

 

b. Type 2 

 

c. Select the CONTINUE> button (ALT + I). 

 

22. Receive the Number Taken window and read the prompt: 

a. “How many tablets did you take the second time you used the product yesterday?” 

 

b. Type 2 

 

c. Select the CONTINUE> button (ALT + I). 

 

23. Receive the Reason Taken window and read the prompt: 

a. “Why do you take this product?” 

 

b. Type “Eye doctor recommended” 

 

c. Select the CONTINUE> button (ALT + I) twice. 

 

Missing Dietary Supplements: When a product is not found based on the brand name, it may be possible 

to select a generic supplement that matches the Supplement Facts on the product label.  For example, if you 

cannot find a calcium and vitamin D supplement under the exact brand name, it can be entered as 

CALCIUM 600 MG +  VITAMIN D 400 IU if the Supplement Facts for this product lists 600 mg of 

calcium and 400 IU of vitamin D per serving.  In cases where the participant is unable to provide a product 

container and does not know the amount of the ingredients but does know that the product contains calcium 

and vitamin D, select DEFAULT CALCIUM WITH VITAMIN D. 

 

24. Receive the Review Product Label window and read the prompt: 

a. “You said you took echinacea in the past 30 days.  Do you have the container for 

this product?” 

 

b. Select the NO button (ALT + N). 

 

25. Receive the Product Search window and read the prompt: 

a. “Please provide the complete name of the product.” 

 

b. The participant is not able to recall the brand name and is unable to tell you 

anything about the ingredients in this product. 

c. TAB to the Product Name pane and highlight DEFAULT ECHINACEA  

 

d. Select VIEW DETAILS button for the product (ALT + D). 

 

NOTE: When possible, compare product label nutrients with ingredient nutrients and amounts.  

If no comparison can be made, select the default. 
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e. Select the CLOSE button (ALT + C) to return to Product Search window. 

 

f. Select the SELECT PRODUCT button (ALT + P). 

 

26. Receive the How Many Days window and read the prompt: 

a. “In the past 30 days, on how many days did you take this product?” 

 

b. Type 15 

 

c. Select the CONTINUE> button (ALT + I). 

 

27. Receive the How Many Taken window and read the prompt: 

a. “On average about how many tablets did you take each day you used the product 

over the past 30 days?” 

 

b. Type 1 

 

c. Select the CONTINUE> button (ALT + I). 

 

28. Receive the How Long Taken window and read the prompt: 

a. “For how long have you been taking this product or a similar type of product?” 

 

b. Type 5 

 

c. TAB to move to the next field, ALT + ↓ to view unit options for length of time. 

 

d. Arrow down to YEARS and TAB to select from list. 

 

e. Select the CONTINUE> button (ALT + I). 

 

29. Receive the Taken Yesterday window and read the prompt:  

a. “Did you take this product yesterday?” 

 

b. Select the NO button (ALT + N). 

 

30. Receive the Reason Taken window and read the prompt: 

a. “Why do you take this product?” 

 

b. Type “For immune support” 

 

c. Select the CONTINUE> button (ALT + I) twice. 
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Reviewing Supplement Product Detail 
1. Receive the Product Review dialog box and read the prompt: 

a. “Now we will review the product information.  Please tell me if I have missed 

anything.” 

 

b. Select the CONTINUE> button (ALT + I). 

 

2. After reviewing the Dietary Supplements information, select CONTINUE RECALL (ALT + I) 

to conclude the interview. 

 

3. Receive the Interview Complete dialog box and read the prompt: “This completes the 

interview.  Thanks for your participation!”  Select the OK button (ENTER). 

 

Managing Projects and Records 
Once you have completed a record, there are several things you may choose to do such as editing, 

creating reports and various data management activities.  Keyboard shortcuts are provided, but you 

may find using the mouse to click and point and the right mouse click to be more efficient for these 

data management activities. 

 

Create Record Reports 
1. Select from the menu bar on the Record Information window: Reports→Foods Report 

(ALT + O then F). 

 

2. If your computer is connected to a printer, select PRINT button (ENTER).  

 

3. Select OK button on the Printing Complete window and the CLOSE button (ALT + C).   

 

4. If your computer is not connected to a printer, select the CLOSE button (ALT + C). 

 

5. Select Reports→Nutrients Per Food Report (ALT + O then N).  Up to 35 nutrients may be 

selected for this report.  Select the default nutrients displayed on this window. 

 

6. Select the OK button (ENTER). 

 

7. Select or use the scroll bar on the right side of the window to view the additional pages of 

the report. 

 

8. If your computer is connected to a printer, select the PRINT button (ALT + P). 

 

9. Select OK button on the Printing Complete window and the CLOSE button (ALT + C). 

 
Checking the Accuracy of Tutorial Data Entry: The sample reports in Appendix 17 have been generated 

from the tutorial exercises, so you can check your work against these reports.  Check the energy (kcal) 

totals as a first comparison.  If there is a discrepancy, checking each food on the Nutrients Per Food Report 

helps to track down the data entry difference.  After checking, edit any foods or amounts that may have 

been incorrectly entered. 

 

10. Select from the menu bar: File→Close (ALT + F then C) or press ESC to close the record or 

TAB to the CLOSE button and press ENTER. 
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Creating a New Folder 
1. Select from the menu bar: Folder→New Folder (ALT + D then E). 

 

2. When you receive the Folder Information window, complete the fields using the 

information below: 

a. Parent Folder: Main Folder 
 
b. Folder Name: My Practice Projects 
 

c. Notes: I’m creating this subfolder to store all of my 
practice projects.  I can delete these projects when 
I’m comfortable with the program. 

 

3. Select the OK button (ENTER).  

 

Move a Project to Another Folder 
1. Highlight the Tutorial – Dietary Recalls project to move. 

 

2. Select from the menu bar: Project→Move (ALT + P then M). 

 

3. When you receive the Move Project to Folder window, select from the drop-down list: My 
Practice Projects to choose a folder to move selected project(s) to. 

 

4. Select the OK button (ENTER). 

 

5. Highlight My Practice Projects folder to confirm that your project has moved into 

the correct folder. 

 

Move a Record to Another Project 
1. Highlight (TAB) the folder My Practice Projects. 

 

2. Select New from the Project menu (ALT + W). 

 

3. When you receive the Project Information window, complete the fields using the 

information below: 

a. Project Name: Tutorial 2 
 
b. Project Abbreviation: Tutorial2 
 
c. Record Type: Recall 
 

d. Dietary Supplement Assessment Module: 24-HOUR AND PAST 30 

DAYS INTAKE (ALT + 3). 

 

4. Select the PREFERENCE button (ALT + P) or press ENTER.   Select the Dietary 

Supplements tab (Right arrow →).  On the Dietary Supplements tab, TAB to REASON FOR 

USE.  Press SPACE BAR to select. 

 

5. Select the OK button (ENTER). 

 

6. Select the OK button again (ENTER). 
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7. Highlight the project named Tutorial – Dietary Recalls (Arrow up ↑) and then 

highlight the record with participant ID 123456789abc (TAB). 

 

8. Select from the menu bar: Record→Move (ALT + R then M). 

 

9. You will receive a window that says “Reminder: If you move records to a project with 

different preferences, data appearance may be altered, and editing (especially of any 

customizable fields) may be affected.” Select the OK button (ENTER) to continue. 

 

10. When you receive the Move Record to Project window, select the project Tutorial2 by 

selecting the OK button (ENTER). 

 

11. Notice that the record 123456789abc is no longer in the project named Tutorial.  

Highlight the project named Tutorial2 on the Project selection pane and notice record 

123456789abc is now listed in this project (TAB until the project is highlighted).   

 

NOTE: You may also use the mouse to drag and drop records into projects of the same record 

type. 

 

Backing Up and Restoring Projects 
1. On the Folder, Project and Record Selection window, highlight the project Tutorial2 

on the Project selection pane and select from the menu bar: Project→Backup→Selected 

(ALT + P then B then S). 

 

2. When you receive the Browse for Folder window, note the backup destination directory.  

Select OK. 

 

3. Select from the menu bar: Project Delete (ALT + P then D). 

 

4. A confirmation message will appear.  Read the message and select the YES button (arrow 

left (←), ENTER). 

 

5. Select from the menu bar: Project Restore (ALT + P then R). 

 

6. When you receive the Select Files to Restore window, select the appropriate directory and 

file.  Select Main Folder and select OPEN.  Select My Practice Projects 
select OPEN.  Select File name: Tutorial 2 backup file.  Select OPEN 

(ENTER). 

 

7. When you receive the Project Information window, select the OK button (ENTER) or select 

the PREFERENCES button to review the project preferences.   

 

8. Note that your deleted project is now restored.   
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User Recipe Tutorial 
Try to complete this section using the same Windows shortcuts as in the Intake Record Tutorials. 

 

Creating a User Recipe Project 
Before you can enter User Recipe data into NDSR, you must create a User Recipe project. 

 

The following steps describe how to create a User Recipe project: 

 

1. On the Folder, Project and Record Selection window, select New from the Project menu 

(ALT + W). 

 

2. When you receive the Project Information window, type User Recipe Project in 

the Project Name: field. 

 

3. Type Recipes in the Project Abbreviation: field. 

 

4. Select USER RECIPE from the drop-down list in the Record Type: field. 

 

5. Type practice session in the Notes: field and type ALT + P or press the 

PREFERENCES button to open the Preferences window.  

 

6. In Method Preferences, TAB to Display to show non-required fields in recipe header. Press 

SPACE BAR to select. 

 

7. TAB to Method Preferences and select Customizable Header (Right arrow →).  TAB to 

HEADER DATA FIELD 1 and type “Recipe Source” as the Descriptor.  Leave the 

CHARACTER LIMIT blank.  
 

8. Select the OK button twice to close the Project Preferences and the Project Information 

windows. 

 

Creating a User Recipe Record 
After you have created a User Recipe project, you can create recipes within that project.  The 

following steps describe how to create a User Recipe record. 

 

1. Highlight the Recipes project and select Record→New (ALT + N). 

 

2. When you receive the Record Information window, complete the fields on the Header tab 

using the information listed below: 

 

Field Name: Entry: 

Recipe ID: Snack Cake 1 

Recipe Name: Old Time Apple Cake 

Serving Size Description: 1 piece 

Interviewer ID: Your initials 

Version: 1 

Site ID: Any alpha/numeric characters 

Recipe Source: Cookbook 

Notes: Use for the low-fat study 
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3. When you have finished entering data, select the CONTINUE RECIPE> button. 

 

Entering a User Recipe Record 
This section of the tutorial covers entering a complete record for one recipe using the Recipe 

window.  You will add yield information and amount details using the Item Detail pane of the 

Food Detail window. 

 

Entering Foods in the Recipe Window 
After you receive the Recipe window, list the ingredients of the recipe.  Descriptive food detail is 

not entered in this window.  Each ingredient is entered on a separate line. 

 

Follow these steps to enter foods in the Recipe window: 

 

1. Type the information listed below into the Recipe window: 

 

NOTE: Make sure you type the information exactly as it appears in the table. 

 

Type: And press: 

sugar, 1 cp ENTER 

apple, 2 ¼ cp ENTER 

egg white, 2 lg ENTER 

whole wheat flour, 1 cp ENTER 

baking powder, 1 ts ENTER 

cinnamon, 1 ts ENTER 

wheat germ, 4 tb  

 

Quick List Entry for Recipes: The amount information can be entered on the Quick List along with the 

ingredient.  Use a comma to separate the food name and the amount (e.g., sugar, 1 cp).  NDSR will probe 

for additional information when the description is incomplete. 

 

2. When you have entered all ingredients in the Recipe window, select the CONTINUE> 

button. 

 

Entering Food Detail 
Follow these steps to enter ingredient detail: 

 

1. When you receive the Food Detail window: 

a. Type 8 in the Servings made: field. 

 

b. Select the REASSIGN (ALT + E) button to begin the search for the NCC Serving 

Count System Food Group. 

 

c. Select: Grains (ALT + I). 

 

d. Select: Cakes, Cookies, Pies, Pastries, Danish, Doughnuts 
and Cobblers – Whole Grain as the NCC Serving Count System 
Food Group: field (ALT + I). 

 



Appendix 4 – NDSR Tutorials  Page A4.33 

e. Type 8 in the Serving Count: field.  Count 8 servings made of this food as 8 

servings of this Food Group. 

 

f. Select the CONTINUE> button. 

 

NCC Food Group Serving Count System Information: The decision to assign this to the Cakes, 

Cookies, Pies, Pastries, Danish, Doughnuts and Cobblers – Whole Grain is based on the grain ingredients.  

The decision to count 8 servings made of this food as 8 servings of Cakes, Cookies, Pies, Pastries, Danish, 

Doughnuts and Cobblers – Whole Grain as the NCC Food Group Serving Count System is based on the 

weight of the ingredients in 1/8 of the recipe (81.708 g).  The FDA serving size for cakes is 80 grams.  

Recipes containing liquid ingredients may require a conversion to allow for moisture loss during baking.  

See “Appendix 10, Food Grouping” for more information. 

 

2. When you receive the Food Search window, describe the sugar: 

a. Choose sugar 

 

b. Choose white granulated 

 

c. When you receive the Food Detail window, you will note that the amount (which 

you typed on the Recipe window is automatically inserted in the Item Detail pane).  

Confirm: 

• Unit: CP – cup 
• Quantity: 1 

 

d. Select the CONTINUE> button to begin the food search for the apple. 

 

3. When you receive the Food Search window, describe the apple:  

a. Choose apple 

 

b. Choose baked or scalloped 

 

c. Choose without skin 

 

d. Choose unsweetened 

 

Food Search: As a rule, recipes list ingredients in the “raw” form.  If the recipe is to be cooked, select the 

cooked NDSR food (e.g., baked or scalloped apple vs. raw apple) with minimal preparation (e.g., 

unsweetened, no fat or salt added in preparation).  The calculations will reflect nutrients for the cooked 

food. 

 

e. Add to the description of the amount of apple using the following information: 

• Unit: CP – cup 
• Quantity: 2 ¼ 
• Form: CPC – cut pieces 
• Cooked: before cooking 

 

Cooked Field: The amount of the apple listed for the recipe is the raw measure.  The Cooked Field permits 

you to specify the amount as measured before or after cooking.  NDSR converts to the appropriate amount.  

As a general rule in recipes, select foods as prepared (cooked) and amounts as measured before cooking 

(raw). 

 

f. Select the CONTINUE> button to begin the food search for the egg white. 
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4. When you receive the Food Search window, describe the egg using the following options: 

a. Choose eggs, white only 

 

b. Choose cooked 

 

c. Confirm the amount of egg using the following information: 

• Unit: LG – large 
• Quantity: 2 

 

d. Select the CONTINUE> button to begin the food search for whole wheat flour. 

 

5. When you receive the Food Search window, describe the flour: 

a. Choose flour, whole wheat 

 

b. Choose use in recipes not containing yeast 

 

Database Specificity: The contribution of phytic acid from whole wheat flour depends on the use of yeast 

in the recipe.  Recipes containing yeast have a lower phytic acid content than non-yeast containing foods. 

 

c. When you receive the Food Detail window, confirm: 

• Unit: CP – cup 
• Quantity: 1 

 

d. Select the CONTINUE> button to begin the food search for the baking powder. 

 

6. Describe the baking powder:   

a. Choose baking powder 

 

b. Choose regular  

 

c. Confirm the amount of baking powder using the following information: 

• Unit: TS – teaspoon 
• Quantity: 1 

 

d. Select the CONTINUE> button to begin the food search for cinnamon. 

 

Expand Search: Baking powder is found during the initial search, but sometimes search results may not 

find the desired food or ingredient.  The “EXPAND SEARCH” feature locates many recipe ingredients (e.g., 

flour, dry cake mix, corn grits, vanilla).  Alternatively, select the Ingredient Hierarchy (type INGR) to 

locate recipe ingredients. 

 

7. Describe the cinnamon: 

a. Choose cinnamon (ground) from the list. 

 

b. Confirm the amount of cinnamon using the following information: 

• Unit: TS – teaspoon 
• Quantity: 1 

 

c. Select the CONTINUE> button to begin the food search for wheat germ. 

 

8. Describe the wheat germ:  

a. Choose the following information from the list: 
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• cereal, ready-to-eat, wheat germ 
• toasted 

 

b. Confirm the amount of wheat germ using the following information: 

• Unit: TB – tablespoon 
• Quantity: 4 

 

c. Select the CONTINUE> button. 

 

9. Verify: 8 Servings made and 8 in the Serving Count on the Food tab.  If edits 

need to be made, highlight Servings made line and press ENTER to reopen the Item 

Detail pane.  Edit as necessary and CONTINUE> (ALT + I). 

a. Select the CONTINUE> button. 

 

10. Press ESC to close the record. 

 

Checking a User Recipe Record 
After entering a User Recipe record, check data entry to determine if the User Recipe is complete 

and accurate and ready to include in other records (menus, intake records, etc.).  The following steps 

describe how to check a User Recipe record:   

 

1. Highlight the project named User Recipe Project.   

 

2. Select Reports→Quality Assurance Reports→Records QA Report (ALT + O then Q then R).   

 

3. The report is a spreadsheet that can be opened or saved for later review.   

 

4. Select the OPEN button.  Report will open as an Excel file, minimized at the bottom of the 

screen.  Click on the Excel icon on the task bar to view the report.  Look at each column.  

 

5. Check the columns in the report against what is highlighted below (other fields have little 

impact on data).  If the nutrients match, it’s safe to assume you have selected the correct 

foods and entered the correct amounts for this recipe.   

a. Project Abbreviation = Recipes 

 

b. User Recipe ID = Snack Cake 1 

 

c. User Recipe Name = Old Time Apple Cake 

 

d. Entry Date = as entered 

 

e. Number of Servings Made = 8 

 

f. Serving Size Description = 1 piece 

 

g. NCC Serving Count System Food Group = Cakes, Cookies, Pies, Pastries, Danish, 

Doughnuts and Cobblers - Whole Grain 

 

h. NCC Serving Count System Food Group Servings = 8 

 

i. Secondary NCC Serving Count System Food Group = blank 
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j. Secondary NCC Serving Count System Food Group Servings = blank 

 

k. NCC Database Food Group = blank 

 

l. Interviewer ID = your initials 

 

m. Sequence = 1 

 

n. Version = 1 

 

o. Site ID = as entered 

 

p. Header Notes = Use for the low-fat study 

 

q. Database Version = 2025 

 

r. Include in Food Search = No 

 

s. QA Status Flag = N 

 

t. Reviewer ID = blank 

 

u. Date of Review = blank 

 

v. Energy = 180.624 kcal 

 

w. Total Fat = 0.802 g 

 

x. Total Carbohydrate = 41.436 g 

 

y. Total Protein = 4.162 g 

 

z. Alcohol = 0 g 

 

aa. Sodium = 76.334 mg 

 

ab.  Header Data Field 1 Descriptor = Recipe Source 

 

ac.  Header Data Field 1 Response = Cookbook 

 

ad.  Header Data Field 2 Descriptor = Header Data Field 2  

 

ae.  Header Data Field 2 Response = blank 

 

af. Header Data Field 3 Descriptor = Header Data Field 3  

 

ag.  Header Data Field 3 Response = blank 

 

ah.  Header Data Field 4 Descriptor = Header Data Field 4 

 

ai.   Header Data Field 4 Response = blank 

 

aj.   Header Data Field 5 Descriptor = Header Data Field 5 
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ak.  Header Data Field 5 Response = blank 

 

6. When you have verified the information, you may close the report and complete the 

Quality Assurance Status: field on the Header tab to document this process. 

a. Select the RECORD REVIEWED checkbox.   

 

b. Enter your initials as the reviewer ID. 

 

7. Select the INCLUDE IN FOOD SEARCH checkbox on the Header tab so this User Recipe will 

become available for inclusion in other NDSR records and select Close. 

 

Adding a User Recipe to Another Record 
 

1. Highlight the project named Tutorial2. 

 

2. Select Record ID 123456789abc. 

 

3. When you receive the Record Information window, select the Food tab. 

 

4. Highlight the 12:30p LUNCH WORK meal information line. 

 

5. Select INSERT MEAL (ALT + M). 

 

6. When you receive the Meal Information window describe the snack: 

a. In the Time: field enter 11a 

 

b. In the Name: field enter SNACK 

 

c. In the Location: field enter WORK 

 

d. TAB to the Foods pane and type Apple Cake 

 

e. Select the CONTINUE> button. 

 

7. At Add Food window, select the CONTINUE> button. 

 

8. Select Old Time Apple Cake (Snack Cake 1) from the list. 

 

9. At the Food Detail window, enter 1 in the Servings Eaten: field. 

 

10. Select the CONTINUE> button to return to the Food tab. 

 

Inserting Items: Inserted foods appear above the food highlighted when INSERT FOOD is selected.  

Inserted meals appear above the meal highlighted when INSERT MEAL is selected. 

 

11. When you have verified the information, select Close (ALT + F then C). 
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DSAM User Product Tutorial 
Try to complete this section using the same Windows shortcuts as in the Intake Record Tutorial. 

 

Creating a User Product Project 
Before you can enter User Product data into NDSR, you must create a User Product project. The 

following steps describe how to create a User Product project. 

 

1. On the Folder, Project and Record Selection window, select New from the Project menu 

(ALT + W). 

 

2. When you receive the Project Information window, type Tutorial User Products 
in the Project Name: field. 

 

3. Type TutorUP in the Project Abbreviation: field. 

 

4. Select DSAM USER PRODUCT from the drop-down list in the Record Type: field. 

 

NOTE: The Dietary Supplement Assessment Module defaults to NONE. 

 

5. Type practice session in the Notes: field. 

 

6. Select the PREFERENCES button.  On the Method tab, TAB until INTERVIEWER ID has 

focus.  Press SPACE BAR to select.   

 

7. Select the OK button twice. 

 

DSAM User Products: The NDSR 2025 DSAM Database includes dietary supplements reported in the 

National Health and Nutrition Examination Survey (NHANES) Dietary Supplement Database 2017-March 

2020 Pre-Pandemic.  A DSAM User Product is a record type that allows for the description of ingredients 

and quantities to create a dietary supplement that does not exist in the DSAM Database.  Once created and 

checked a DSAM User Product may be included in product search and selected during the DSAM 

interview.  Products identified as Missing Products during the dietary interview may be saved, completed, 

reviewed, and included in product search for inclusion in the dietary intake record. 

 

Creating a User Product Record 
After you have created a User Product project, you can create products within that project.  The 

following steps describe how to create a User Product record. 

 

1. Highlight the Tutorial User Products project and select Record→New (ALT + N). 

 

2. When you receive the Record Information window, complete the fields on the Header tab 

using the information listed below: 
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Field Name Entry 

Product ID: 2025-001 

Interviewer ID: Your initials 

Product name: XYZ for Joint Relief 

Serving size quantity: 2 

Serving size unit: Tablet 

Brand name: XYZ 

Manufacturer/distributor: Leave blank 

City name: Leave blank 

State: Leave blank 

Contact information: Leave blank 

Product information source: Bottle/label 

Include in Product Search: 
Check this box only after entering product 

information and checking data entry. 

 

3. When you have finished entering data, select the CONTINUE> button. 

 

Entering a User Product Record 
This section of the tutorial covers entering a complete record for one product using the User 

Product window. 

 

Entering Product Ingredients in the Add Ingredients Window 
In the Add Ingredients window, list the ingredients of the product.  Each ingredient is entered on a 

separate line. 

 

Follow these steps to enter ingredients into the Add Ingredients window: 

 

1. Type the information listed below into the Add Ingredients window: 

 

NOTE: Make sure you type the information exactly as it appears in the table. 

 

Type: And press: 

calories, 10 kcal ENTER 

total carbohydrate, 2 gm ENTER 

dietary fiber, 1 gm ENTER 

sodium, 120 mg ENTER 

glucosamine sulfate, 1500 mg ENTER 

chondroitin sulfate, 1200 mg ENTER 

MSM, 500 mg  
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Ingredient Entry for User Products: While ingredients can be added one at a time, you may find it more 

efficient to enter all of the ingredients from the product container at one time before proceeding.  The 

amount information can be entered on the Add Ingredients window along with the ingredient.  Use a 

comma to separate the ingredient name and the amount.  NDSR will prompt for additional information 

when needed. 

 

2. When you have entered all ingredients in the Add Ingredients window, select the 

CONTINUE> button. 

 

3. Receive the Ingredient Search window.  Press OK to select CALORIES. 

 

4. Receive the Product Ingredients tab.  Confirm the calorie information:  

a. Quantity: 10 
 
b. Unit: kcal 
 

c. Select the CONTINUE> button to begin the search for total carbohydrate. 

 

5. Receive the Ingredient Search window.  Press OK to select TOTAL CARBOHYDRATE. 

 

6. Receive the Product Ingredients tab.  Confirm total carbohydrate information: 

a. Quantity: 2 
 

b. Unit: gm 
 

c. Select the CONTINUE> button to begin the search for dietary fiber. 

 

7. Receive the Ingredient Search window.  Press OK to select DIETARY FIBER. 

 

8. Receive the Product Ingredients tab.  Confirm the dietary fiber information: 

a. Quantity: 1 
 
b. Unit: gm 
 

c. Select the CONTINUE> button to begin the search for sodium. 

 

9. Receive the Ingredient Search window.  Scroll to SODIUM.  Press OK to select. 

 

10. Receive the Product Ingredients tab.  Confirm the sodium information: 

a. Quantity: 120 
 
b. Unit: mg 
 

c. Select the CONTINUE> button to begin the search for glucosamine sulfate. 

 

11. Receive the Ingredient Search window.  Scroll to GLUCOSAMINE SULFATE.  Press OK 

to select. 

 

12. Receive the Product Ingredients tab.  Confirm the glucosamine sulfate information: 

a. Quantity: 1500 
 
b. Unit: mg 
 

c. Select the CONTINUE> button to begin the search for chondroitin sulfate. 
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13. Receive the Ingredient Search window.  Scroll to CHONDROITIN SULFATE.  Press OK 

to select. 

 

14. Receive the Product Ingredients tab.  Confirm the chondroitin sulfate information: 

a. Quantity: 1200 
 
b. Unit: mg 
 

c. Select the CONTINUE> button to begin the search for MSM. 

 

15. Receive the Ingredient Search window.  Scroll to MSM 
(METHYLSULFONYLMETHANE).  Press OK to select. 

 

16. Receive the Product Ingredients tab.  Confirm the MSM (methylsulfonylmethane) 

information: 

a. Quantity: 500 
 

b. Unit: mg 
 

c. Select the CONTINUE> button. 
 

Selecting Ingredients: Enter the information from the supplement facts, not from the ingredients section 

on the label.  Supplement Facts Panels generally list the amount of an elemental mineral rather than the 

mineral compound which is often also listed in parenthesis.  Enter the elemental mineral.  For example, 

calcium (as calcium carbonate) 600 mg should be entered as calcium, 600 mg. 

 

Checking a User Product Record 
After entering a User Product, check data entry to determine if the User Product is complete, 

accurate and ready to include in intake records. Compare the DSAM User Product Report to make 

sure that the serving size quantity and the supplement ingredients have been entered correctly.  

 

1. Select Reports→DSAM User Product Report (ALT + O then P).  If you are connected to a 

printer, select PRINT (ALT + P) or SAVE (ALT + S) the PDF. 

 

2. Compare the following: 

a. Calories = 10 kcal 

 

b. Total Carbohydrate = 2 gm 

 

c. Dietary Fiber = 1 gm 

 

d. Sodium = 120 mg 

 

e. Glucosamine Sulfate = 1500 mg 

 

f. Chondroitin Sulfate = 1200 mg 

 

g. MSM (Methylsulfonylmethane) = 500 mg 

 

3. When you have verified the information, close the report, return to the Header tab, and 

check the box RECORD REVIEWED.  Enter your initials as the reviewer.   

 

4. Check the box INCLUDE IN PRODUCT SEARCH.   
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5. Select Close to close the record.   

  

Saving a Missing Product to the DSAM Database 
After you have created a User Product Project, you can resolve Missing Products and save them to 

the DSAM database for access in other dietary intake records. 

 

1. Highlight the project named Tutorial2. 

 

2. Select Record ID 123456789abc.  Press ENTER. 

 

3. When you receive the Record Information window, select the Dietary Supplements tab. 

 

4. Highlight the Missing Product Macuvite Eye Care.  Press ENTER. 

 

5. When you receive the Product Detail window select the MISSING PRODUCT DETAIL button 

(ALT + M). 

 

6. When you receive the Missing Product Detail window, select SAVE AS USER PRODUCT 

button (ALT + S). 

 

7. When you receive the Save Record As window, select the project TutorUP from the list.  

Press TAB and enter 2025-002 as the Product ID.  Select the OK button. 

 

8. When you return to the Missing Product Detail window, select the FINISH LATER button 

(ALT + F). 

 

9. When you receive the Product Detail window, select the FINISH LATER button (ALT + F). 

 

10. When you receive the Dietary Supplements tab, select Close to close the record. 

 

11. Highlight the project named Tutorial User Products. 

 

12. Select Macuvite Eye Care from the list.  Press ENTER. 

 

13. TAB to Interviewer ID: field.  Enter your initials and press TAB.  Select the 

CONTINUE> button. 

 

14. Receive the Product Ingredients tab.  Confirm the entry of the dietary supplement 

ingredients. 

 

Confirming Dietary Supplement Product Information: If you have the product container, you may use 

that to double check that you have correctly entered the supplement ingredients and amounts.  If no 

container is available, use other resources such as the product website.   

 

15. When you have verified the information, return to the Header tab.  Use the mouse to check 

the box INCLUDE IN PRODUCT SEARCH. 

 

16. Select Close to return to the Folder, Project and Record Selection window. 

 

17. Highlight the project named Tutorial2. 

 

18. Select Record ID 123456789abc.  Press ENTER. 
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19. When you receive the Record Information window, select the Dietary Supplements tab. 

 

20. Highlight the Missing Product Macuvite Eye Care.  Press ENTER. 

 

21. When you receive the Product Detail window select the PRODUCT button (ALT + P). 

 

22. When you receive the Product Search window, note that Macuvite Eye Care 
(2025-002) is in the Find: field.  Select this product (ALT + P). 

 

23. When you receive the Product Detail window select the CONTINUE> button. 

 

24. After reviewing your edit, select Close to close the record.  Select File→Exit to exit the 

program. 


